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Preface

This Users’ Guide supports the use of the COTLEASE  Lotus 1-2-3 release 5.0
template on either conventional Windows 3.1 or Windows 95 microcomputer
operating systems.  This program was developed in conjunction with a similar
program for rice, RICELEASE; there is also a GRNLEASE template for the major
grain crops subject to the FAIR Act of 1996.  A paper entitled “Landowner/Tenant
Issues in the Texas Rice Industry,” Agricultural and Food Policy Center Policy
Issues Paper 96-3, has been written to address some tenant landowner issues in the
Texas Rice industry.  Although that paper does not speak of cotton or grain, it
provides useful information about the FAIR Act, and it’s effects on agriculture.   
Even though cotton- and grain-related market transition payments are of much
lower magnitude ($/ac) than for rice, similar sets of software were prepared for
use by operators and landowners.  Copies of the software, Users’ Guide, and the
noted paper may be obtained either through your local county agent, Larry
Falconer at Corpus Christi (512/265-9203), or Joe Outlaw in College Station
(409/845-3062).

The development of this software was funded by the Texas Agricultural
Experiment Station (project H-3914), Texas Agricultural Extension Service,
Texas Rice Research Foundation, and Rice Belt Warehouse, Inc.

Installation Instructions

The Cotton Land Tenure Evaluation software is a Lotus template.  This means
that the program must be run using Lotus 1-2-3.  This program is designed to run
with either Windows 95 or Windows 3.1 or higher operating systems, and Lotus
1-2-3 release 5.  A computer with 8mb of RAM and a 486 processor is also
recommended, but not required.  Since the program is a Lotus template, 
Lotus 1-2-3 r 5 must be running before you can load the program.  Once inside
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Lotus, you must open a file.  At the top of the Lotus program you will notice a
menu bar with several menu options on it.  In the top left corner is the “File”
menu item.  To open a file, pull down the “File” menu and click the “Open”
option.  Upon selecting the Open option, the Open File dialog box will appear, as
shown on the bottom of the previous page.

 Under the “Drives” section, select the letter of the 3.5 inch drive on your
computer.  Then select the file entitled COTLEASE.WK4 from the list of files
appearing along the left side.  Click the OK button, and Lotus 1-2-3 r 5 will bring
up the Cotton Land Tenure Evaluation program.  You will note there are several
sheets comprising this spreadsheet file; the customized menu features
incorporated into the COTLEASE.WK4 file facilitate moving from one area of
the spreadsheet to another as necessary.  

After the program has loaded up the first thing you should see is the opening

screen below:
If you do not see the opening screen above, something is not working properly. 
Try and reload the file, going back through the steps outlined above.  If problems
persist, call Joe Outlaw in College Sation (409/845-3062).
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Overview

What the Cotton Land Tenure Evaluation Program is designed to do:  This
Lotus template takes enterprise budget information for cotton farm operations and
evaluates the expected returns to producers and landowners under various lease
scenarios.  The landowners’ results from renting the land for cotton farming, are
compared with their receiving 100% of  the returns from market transition
payments plus the user-specified net returns from an alternative enterprise, thus
calculating the net advantage to landowners for renting their land for cotton
production under the budgeted scenario over the life of the FAIR Act.

The Cotton Land Tenure Evaluation program allows the user to evaluate any
desired share arrangement, but for ease of use, it contains ten default lease share
options that the user may select from, and then modify if desired.    

The user can print any one of six programmed reports by using the Print option on
the menu.  These reports include: 1) the base data on program yields, expected
prices, and market transition payments; 2) land tenure arrangements (landowners’
percentage of different cost items being shared); 3) enterprise budget information;
4) sensitivity table analyses for both the tenant and landowner for the current
operating period; 5) sensitivity table analyses for the tenant over the life of the
FAIR Act; and 6) sensitivity table analyses for the landowner over the life of the
FAIR Act.  The user may also print all six reports at once.  An example of each of
these reports appears toward the end of this Users’ Guide.

Limitations:  This program was designed with a very specific purpose in mind,
that being to identify expected returns to landowners for two basic alternatives: (a)
continuing to engage their land in cotton production, considering alternative
tenure arrangements, expected production costs, and ranges of expected yields,
and prices; and (b) ceasing use of their land in cotton production, and engaging it
instead in an alternative use, whereby they realize 100% of the market transition
payments and the user-specified net returns for the alternative enterprise. 
Therefore, it is limited in its analytical capabilities.  The Cotton Land Tenure
Evaluation is not designed to:

� Be prescriptive, i.e, indicate what one should do -- it simply evaluates
alternatives based on user-supplied data.

� Evaluate leasing options for alternative enterprises -- this program only
evaluates cotton leases.
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� Account fully for risk management -- it does not incorporate users’
subjective probabilities for expected yields and prices, the option of crop
insurance, or the effects of marketing contracts, among other possible
considerations.

� Allow for direct, side-by-side comparisons of tenure arrangements for the
cotton enterprise as well as for other cropping alternatives.

A more comprehensive software program designed to address the above issues
will be available during the Summer of 1997.

Please Note:

The user may enter data in the cells that appear in blue text; blue text is
“unprotected,” allowing for users to change it, replacing it with their own values. 
All other cells are programmed as formulas, and should not be changed by the
user.  Doing so will corrupt the integrity of the program and result in the output
being inaccurate.  To protect against such accidental changes of formula cells,
users are encouraged to maintain one or more original versions of the program in
a secure location.  Note: in this Users’ Guide, the unprotected cells appear in a
light shade of grey.     

Moving around the program: To move from one section to the next, simply
access the pull- down menus located at the top of the screen.  Inside the “move to”
pull-down menu is a list of all the places that you can go to inside the program.  
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To move around within any of the data entry or analysis sections, use the mouse in
conjunction with the horizontal and vertical scroll bars at the right hand side and
bottom of the display.  The arrow keys may also be used to move within a page.

Required Data  

The data required to generate results are entered into the (a) Base Data, (b) Land
Tenure,  and (c) Budget sections.  These data include:

Base Data Section:

Analysis Description: This label is the information that will be printed in the
heading of all the pre-programmed reports.  It provides the user with the capability
of labeling different analyses.

Farm Payment Yield: The established yield for a particular Farm Service Agency
(FSA) farm unit; this yield is used by the FSA for determination of market
transition payments.  Be sure to adjust this figure to the appropriate level for the
farm unit being analyzed.

Cotton Yield: Expected ginned lint cotton yield (lbs/ac) for the farm unit being
evaluated.

Cotton Price: Expected harvest time price ($/lb) for ginned cotton lint during the
budgeted period.

+/- Increments for What If : The price and yield increments in $/lb and lbs/ac
that are used to define alternative price and yield levels for the tenant and
landowner sensitivity analysis tables.  This program calculates returns under
various yield and price scenarios.  The yield and price specified, along with the +/-
increments, define the different yield and price levels used to calculate the returns. 
The sensitivity calculations are presented both for +/- one and +/- two increments
about the specified yield and price levels, i.e. a total of twenty-five different yield
and price combinations are evaluated.

Alternative Return : These values represent net cash flows from the next best
alternative enterprise that will accrue to the landowner if the land is not rented to a
tenant for cotton production.  These values are used to calculate the net advantage
to the landowner for allowing the land to remain in cotton production, and be
farmed by a tenant producer.

Annual discount rate: This value is used in net present value calculations to
adjust the tenant’s and landowners’ cash flows to evaluate the net returns per acre
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over the 1997-2002 period.  A desired rate of return for the land in the analysis
could be used (e.g., 5-7%) or, alternatively, users may choose to use their
opportunity cost of capital for borrowed funds (e.g., 7-12%).  Returns for the 1996
crop year are not included in the net present value calculations since this crop year
is in the past, and as such, does not affect future decisions.  Note: once the 1997
crop year has occurred, 1997 consequences should be excluded from the NPV
calculations; call Joe outlaw (409/845-3062) or Ed Rister (409/845-3801) for
information on how to make these revisions. 

Land Tenure Section:

Analyze : This column of values is the current tenure arrangement being
evaluated.  These data may be selected from a set of default options from the
menu bar using the Analyze menu.  The user has the option of customizing these
scenarios by entering alternative values, or he/she may enter an entirely new
alternative directly into the worksheet.  The user may also alter the percentages
that are shown in the ten customized tenure arrangements, even though the text is
black.  These cells are not formulas and changing them will not affect the
operation of the program.  Any tenure specific allocation changes that the user
wishes to keep for subsequent analytical sessions  need to be saved prior to exiting
the program.  Then, the next time the program is opened, the customized tenure
arrangements will be available, including any saved changes; be advised,
however, that the original tenure arrangements that were altered will no longer be
available — for that reason, users are advised to keep an original version of the
template stored in a secure location.

Enterprise Budget Section:

Pounds of Cotton Seed per Pound of Lint: The number of pounds of cotton
seed that are associated with the production of one pound of ginned cotton lint,
e.g., 1.62 is a standard norm for this value.

Variable Production Input Levels and Costs:  All of the data entry regarding
costs and inputs are done in the Enterprise Budget Section. These data are mainly
usage rates of variable inputs with corresponding costs.  Fixed costs may be
entered on a per acre basis near the bottom of the enterprise budget (while these
fixed costs will appear in the printed enterprise budget report, they are not
considered in other aspects of the analysis (e.g., the sensitivity tables) as the fixed
costs are considered irrelevant to the “grow cotton” vs “pursue an alternative
enterprise” decision -- that is, the fixed costs will occur regardless of the
enterprises grown on the land).  The areas that require data entry are colored with
blue text, to symbolize a data entry cell.  Do not enter data in cells that do not
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have blue text -- this will cause a formula to be erased, and the program to
function improperly (refer to the Please Note item at the top of p. 4).  

Menu Options

File Menu:

The File Menu can be accessed by clicking on the File section of the menu.  The
File Menu contains options for opening, closing, and saving files.  

Open : the Open command allows the user to open a new file inside the Lotus
program.    If you open a new file, you will be leaving the Cotton Land Tenure
Evaluation program and opening another Lotus Spreadsheet file. 

Close : the Close command allows the user to close a file inside the Lotus
program.  If you choose the Close option, then you will be closing the Cotton
Land Tenure Evaluation program.  It is recommended that the user save the
current file by using the Save As option and entering an analysis-specific file
name before closing.

Save As? : the Save As?  command allows the user to save the current file.  You
may save the file under the current name, or change the name of the file and
preserve the data under a analysis- specific file name.  It is recommended to
periodically save the file as you progress through the worksheet.  This helps to
prevent data loss due to an accidental data entry, or unforeseen program shutdown
by the computer system. 

Exit : the Exit  command allows the user to exit the Cotton Land Tenure
Evaluation program and the Lotus 1-2-3 program.  It is recommended that the user
save the data as discussed above before exiting.  

Print Menu:

The Print menu is a customized menu that allows the user to print a variety of
reports.  The option exists to print either one report at a time, all reports at once,
or a user-specified combination of the six.  The user can access the print menu by
clicking the Print option on the customized main menu bar.  After clicking on the
Print menu, the user is presented with the Print dialog box shown at the top of the
next page.
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Inside the dialog box, the user can select any combination of six pre-defined
reports, and a cover page.  To select the items to be printed, click on the box next
to the title of the report(s) to be printed and click OK.  Be sure your printer is on
and loaded with paper before executing this print command.

The available reports include: 

Base Data on Yields, Prices, and Transition Payments: this report contains the
base data on FSA program yield, expected yields, expected price, annual $/ac cash
flows for an alternative enterprise over the remaining life of the FAIR Act, and the
discount rate used in the analysis for net present value calculations.

Land Tenure Arrangements: the specific land tenure arrangement (percentage
of crop returns and different cost items being shared) that is being analyzed for the
particular scenario, along with the rest of the available alternatives..

Enterprise Budget Information: the enterprise budget information that
represents the cost structure for the specific cotton production scenario that is
being analyzed.

Sensitivity table for landowner and tenant, net of payments: the sensitivity
table analyses for both the tenant and landowner for only the current operating
period, net of (ignoring) any transition payments.  

Sensitivity table for tenant over the life of the FAIR Act: the sensitivity table
analyses for the tenant over the life of the FAIR Act (1996 -2002), including



11

tenant’s designated share of transition payments.  Positive values indicate returns
exceed all variable costs while negative values indicate the opposite.

Sensitivity table for the landowner over the life of the FAIR Act: the left side
represents the sensitivity table analyses for the landowner continuing to rent
his/her land to a tenant producer for cotton farming over the life of the FAIR Act
(1996-2002), including landowners’ designated share of transition payments. 
Positive values indicate landowners’ share of returns exceed landowners’ share of 
variable costs while negative values indicate the opposite.  The middle column of
values represents the respective annual net returns realized by landowners who
discontinue their cotton lease and engage their land in its next best use, while also
receiving 100% of the market transition payments.  The right side of this output
represents the net advantage to the landowner for continuing use of his/her land in
cotton production compared to using it in the specified next best use and receiving
100% of the market transition payments.  A positive value indicates returns are
highest if cotton production is continued with a tenant while a negative value
signals the landowners’ pursuit of the next best alternative accompanied by their
receipt of 100% of the market transition payments is more profitable.

The user may also print all six reports at once by selecting the All Information
option from the dialog box.

Analyze Menu:

The Analyze menu allows the user to select any of ten pre-defined land tenure
arrangements.  A user can select the option they would like to analyze by clicking
on the desired selection with the mouse, or by using the arrow and enter keys. 
The program then over-writes the contents of the Analyze column in the Budget
page, and immediately updates all calculations to reflect the desired tenure
arrangement.  If the user changes any component of the tenure or budget data,
the REFRESH menu item needs to be executed as described below before the
changes are valid.  

Move To Menu:

The Move To menu allows the user to move around throughout the worksheet. 
By selecting one of the seven options, the user can move to the sections specified
by that option.

Misc Menu:

The Miscellaneous menu allows you to either (a) switch to the Lotus 1-2-3 menu
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or (b) refresh the data and calculations inside the worksheet.

Reset to 1-2-3 menus: this command allows the user to toggle to the standard
Lotus 1-2-3 menu system.  If you do toggle to the standard menu, after completing
the intended Lotus tasks, you may then return to the Cotton Land Tenure
Evaluation program’s customized menus by selecting the Menu option that has
been added on the far right side of the standard Lotus 1-2-3 menu bar.  

*IMPORTANT*

Refresh: allows a user who has changed data within the land tenure section
or the enterprise budget section to recalculate the sensitivity tables using the
new data values.  For example, if you select the 1/4a share arrangement from
the Analyze menu, then the program automatically computes the sensitivity
tables using that data.  However, if you go to the land tenure section and
adjust the percentages after having selected a tenure alternative, the
program will not automatically update the tables.  Similarly, if you make an
adjustment in the Enterprise Budget section or elsewhere, such changes are
not automatically reflected in the results sections.  The user must move to the
Misc menu and choose the Refresh option.  The program then uses the data
that has just been changed and re-calculates the sensitivity tables.

Help: The Help menu allows you to access the Lotus 1-2-3 help screens.

Reports

Each of the following six pages is an example presentation of the six respective
reports that may be generated using this program.  The values used in this
example are for a case farm situation in District 11, identified in December of
1996.
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 Cotton --Texas Coastal Bend (District 11)
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������ lbs/ac 520.00
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 % 85.00%
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������� $/lb $0.71
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 $/lb $0.025

�
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�� ��
��
�
������
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�  ! $/lb $0.0888 $/ac ($12.00)

�  " $/lb $0.0725 $/ac ($12.00)

�  # $/lb $0.0772 $/ac ($12.00)

�   $/lb $0.0715 $/ac ($12.00)

$%%% $/lb $0.0682 $/ac ($12.00)

$%%� $/lb $0.0553 $/ac ($12.00)

$%%$ $/lb $0.0536 $/ac ($12.00)

�

����������

���
� % 10.00%
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Land Tenure Arrangements &�
��'
��(��)*����������	��
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�
Cotton --Texas Coastal Bend (District 11) 1/4a 1/4b 1/3a 1/3b 1/5a 1/5b C25 C35 C50 C0

Analyze #3 #4 #1 #2 #1 #2 #5 #6 #7 #8

�+/+01+)
COTTON LINT (lbs/ac) 33.33% 25.00% 25.00% 33.33% 33.33% 20.00% 20.00% 0.00% 0.00% 0.00% 0.00%
COTTON SEED 33.33% 25.00% 25.00% 33.33% 33.33% 20.00% 20.00% 0.00% 0.00% 0.00% 0.00%
CASH RENT $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00 $25.00 $35.00 $50.00 $0.00
OTHER 33.33% 25.00% 25.00% 33.33% 33.33% 20.00% 20.00% 0.00% 0.00% 0.00% 0.00%
OTHER 33.33% 25.00% 25.00% 33.33% 33.33% 20.00% 20.00% 0.00% 0.00% 0.00% 0.00%
GROSS RECEIPTS
=========================

/��2��&+��3)-)

SEED 33.33% 25.00% 0.00% 33.33% 0.00% 20.00% 0.00% 0.00% 0.00% 0.00% 0.00%
HERBICIDE 33.33% 25.00% 0.00% 33.33% 0.00% 20.00% 0.00% 0.00% 0.00% 0.00% 0.00%
INSECTICIDES 33.33% 25.00% 0.00% 33.33% 0.00% 20.00% 0.00% 0.00% 0.00% 0.00% 0.00%
FERTILIZER 33.33% 25.00% 0.00% 33.33% 0.00% 20.00% 0.00% 0.00% 0.00% 0.00% 0.00%
PIX (Growth Regulator) 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
DEFOLIANT 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
LABOR 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
FUEL 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
REPAIRS 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
APPLICATIONS -- AERIAL 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
APPLICATIONS -- GROUND 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
IRRIGATION 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
HARVESTING 33.33% 25.00% 0.00% 33.33% 0.00% 20.00% 0.00% 0.00% 0.00% 0.00% 0.00%
HAULING 33.33% 25.00% 0.00% 33.33% 0.00% 20.00% 0.00% 0.00% 0.00% 0.00% 0.00%
GINNING 33.33% 25.00% 0.00% 33.33% 0.00% 20.00% 0.00% 0.00% 0.00% 0.00% 0.00%
STORAGE 33.33% 25.00% 0.00% 33.33% 0.00% 20.00% 0.00% 0.00% 0.00% 0.00% 0.00%
BOLL WEEVIL ERADICATION PROGRAM 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
SCOUTING 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
OTHER 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
INTEREST (weighted int rate) 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

=========================

�24+���3)-)

DEPRECIATION 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
INSURANCE 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
REPAIRS 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
TAXES (property) 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
INTEREST ON CAPITAL INVESTMENT 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
OTHER FC 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%
OTHER FC 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 0.00%

Share of Transition Payment 33.33% 25.00% 25.00% 33.33% 33.33% 33.33% 33.33% 0.00% 0.00% 0.00% 0.00%

Tenure Arrangement Label 1/3a 1/4a 1/4b 1/3a 1/3b 1/5a 1/5b C25 C35 C50 C0
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Pound of Cotton Seed per Pound of Lint 1.62

COTTON PRODUCTION ENTERPRISE BUDGET Cotton --Texas Coastal Bend (District 11)

************************************************************************************************************************
Owner/Operator Tenant Landowner LAND RENTAL

UNITS/AC $/UNIT $/AC $/AC $/AC TERMS

REVENUES 1/3a
==========================================================================================
COTTON LINT (lbs/ac) 625.0 $0.71 $443.75 $295.83 $147.92 33.33%
COTTON SEED ($/ton) 0.5 95.00 48.09 32.06 $16.03 33.33%
CASH RENT($/ac) 0.00 0.00 0.00 $0.00
OTHER 0.00 0.00 0.00 0.00 0.00 33.33%
OTHER 0.00 0.00 0.00 0.00 0.00 33.33%
GROSS RECEIPTS $491.84 $327.90 $163.95 n/a
==========================================================================================

VARIABLE COSTS

SEED 1 16.20 16.20 10.80 5.40 33.33%
HERBICIDE 1 8.75 8.75 5.83 2.92 33.33%
INSECTICIDES 1 59.04 59.04 39.36 19.68 33.33%
FERTILIZER 1 19.65 19.65 13.10 6.55 33.33%
PIX (Growth Regulator) 1 6.86 6.86 6.86 0.00 0.00%
DEFOLIANT 1 11.00 11.00 11.00 0.00 0.00%
LABOR 1 11.69 11.69 11.69 0.00 0.00%
FUEL 1 11.14 11.14 11.14 0.00 0.00%
REPAIRS 1 3.48 3.48 3.48 0.00 0.00%
APPLICATIONS -- AERIAL 1 28.00 28.00 28.00 0.00 0.00%
APPLICATIONS -- GROUND 1 0.00 0.00 0.00 0.00 0.00%
IRRIGATION 1 0.00 0.00 0.00 0.00 0.00%
HARVESTING 625 0.10 62.50 41.67 20.83 33.33%
HAULING 625 0.00 0.00 0.00 0.00 33.33%
GINNING 625 0.11 67.50 67.50 0.00 33.33%
STORAGE 625 0.00 0.00 0.00 0.00 33.33%
Boll Weevil Eradication Program 1 23.14 23.14 23.14 0.00 0.00%
Scouting 1 5.00 5.00 5.00 0.00 0.00%
OTHER 1 0.00 0.00 0.00 0.00 0.00%
INTEREST (weighted int rate) 333.95 0.0340 11.35 11.35 0.00 0.00%

Variable Costs sub-total $345.30 $289.92 $55.38 n/a

Returns Above Variable Costs 146.54 37.97 108.57
==========================================================================================

FIXED COSTS

DEPRECIATION 1 42.72 $42.72 42.72 0.00 0.00%
INSURANCE 1 0.00 $0.00 0.00 0.00 0.00%
REPAIRS 1 0.00 $0.00 0.00 0.00 0.00%
TAXES (property) 1 0.00 $0.00 0.00 0.00 0.00%
INTEREST ON CAPITAL INVESTMENT 1 0.00 $0.00 0.00 0.00 0.00%
OTHER FC 1 0.00 $0.00 0.00 0.00 0.00%
OTHER FC 1 0.00 $0.00 0.00 0.00 0.00%

Fixed Costs sub-total $42.72 42.72 0.00

==========================================================================================
TOTAL COSTS/ACRE $388.02 $332.64 $55.38
==========================================================================================
TOTAL NET/ACRE --Return  to Land and Profit $103.82 ($4.75) $108.57
==========================================================================================
Break-even Price, All Production Costs le $/lb $0.621 $0.532 $0.089
Break-even Price, All Production Costs $/lb $0.621 $0.532 $0.089
Break-even Price, Variable Costs $/lb $0.552 $0.464 $0.089
Break-even Price, Fixed Costs $/lb $0.068 $0.068 $0.000
==========================================================================================
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Cotton --Texas Coastal Bend (District 11)

Net of Transition Payments
5*�
�2��-�6�������-�
�

��7��
��
���6����/����6������
�8

������79��68 1/3a
�������� $0.66 $0.69 $0.71 $0.74 $0.76

����� 525.00 (13.82) (5.07) 3.68 12.43 21.18

7�6���8 575.00 1.66 11.24 20.83 30.41 39.99
625.00 17.14 27.55 37.97 48.39 58.80
675.00 32.62 43.87 55.12 66.37 77.62
725.00 48.09 60.18 72.26 84.34 96.43

5*�
�2��-�6�������&�
��'
����7��
��
���6����/����6������
�8

Cotton ������79��68 1/3a
�	��
���� $0.66 $0.69 $0.71 $0.74 $0.76

����� 525.00 76.92 81.29 85.67 90.04 94.42

7�6���8 575.00 87.54 92.33 97.12 101.91 106.70
625.00 98.15 103.36 108.57 113.78 118.98
675.00 108.77 114.39 120.02 125.64 131.27
725.00 119.38 125.42 131.47 137.51 143.55
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Base w/o transition payments
Yield 1/3a
(lb/ac) ������79��68
�������� $0.66 $0.69 $0.71 $0.74 $0.76

525.00 (13.82) (5.07) 3.68 12.43 21.18
575.00 1.66 11.24 20.83 30.41 39.99
625.00 17.14 27.55 37.97 48.39 58.80
675.00 32.62 43.87 55.12 66.37 77.62
725.00 48.09 60.18 72.26 84.34 96.43

Annual, considering transition payments

1996 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 12 21 30 39 47
575.00 28 37 47 57 66
625.00 43 54 64 75 85
675.00 59 70 81 93 104
725.00 74 86 98 111 123

1997 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 8 16 25 34 43
575.00 23 33 42 52 61
625.00 39 49 59 70 80
675.00 54 65 76 88 99
725.00 69 82 94 106 118

1998 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 9 18 26 35 44
575.00 24 34 44 53 63
625.00 40 50 61 71 82
675.00 55 67 78 89 100
725.00 71 83 95 107 119

1999 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 7 16 25 34 42
575.00 23 32 42 51 61
625.00 38 49 59 69 80
675.00 54 65 76 87 99
725.00 69 81 93 105 117

2000 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 6 15 24 33 41
575.00 22 31 41 51 60
625.00 37 48 58 68 79
675.00 53 64 75 86 98
725.00 68 80 92 104 117

2001 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 2 11 20 29 37
575.00 18 28 37 47 56
625.00 33 44 54 65 75
675.00 49 60 71 83 94
725.00 64 76 89 101 113

2002 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 2 11 19 28 37
575.00 17 27 37 46 56
625.00 33 43 54 64 75
675.00 48 60 71 82 93
725.00 64 76 88 100 112

NPV* $0.66 $0.69 $0.71 $0.74 $0.76
525.00 27 65 103 141 179
575.00 94 136 178 219 261
625.00 161 207 252 298 343
675.00 229 278 327 376 425
725.00 296 349 402 454 507

*NPV is  for 1997-2002, discounted into 1997 $s .
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Cotton  is grown No Cotton Advantage to growing Cotton 
Base w/o transition payments Base w/o transition payments

Yield 1/3a Yield 1/3a
(lb/ac) ������79��68 (lb/ac) ������79��68
�	��
���� $0.66 $0.69 $0.71 $0.74 $0.76 �	��
���� $0.66 $0.69 $0.71 $0.74 $0.76
525.00 76.92 81.29 85.67 90.04 94.42 525.00 88.92 93.29 97.67 102.04 106.42
575.00 87.54 92.33 97.12 101.91 106.70 ($12.00) 575.00 99.54 104.33 109.12 113.91 118.70
625.00 98.15 103.36 108.57 113.78 118.98 625.00 110.15 115.36 120.57 125.78 130.98
675.00 108.77 114.39 120.02 125.64 131.27 675.00 120.77 126.39 132.02 137.64 143.27
725.00 119.38 125.42 131.47 137.51 143.55 725.00 131.38 137.42 143.47 149.51 155.55

Annual, considering transition payments Annual, considering transition payments

1996 $0.66 $0.69 $0.71 $0.74 $0.76 1996 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 90 94 99 103 108 525.00 63 67 71 76 80
575.00 101 105 110 115 120 575.00 73 78 83 88 93
625.00 111 116 122 127 132 $27.26 625.00 84 89 94 100 105
675.00 122 127 133 139 144 675.00 95 100 106 111 117
725.00 132 139 145 151 157 725.00 105 111 117 123 129

1997 $0.66 $0.69 $0.71 $0.74 $0.76 1997 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 88 92 96 101 105 525.00 68 72 76 81 85
575.00 98 103 108 113 117 575.00 78 83 88 93 97
625.00 109 114 119 124 130 $20.07 625.00 89 94 99 104 110
675.00 119 125 131 136 142 675.00 99 105 111 116 122
725.00 130 136 142 148 154 725.00 110 116 122 128 134

1998 $0.66 $0.69 $0.71 $0.74 $0.76 1998 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 88 93 97 101 106 525.00 66 71 75 79 84
575.00 99 104 108 113 118 575.00 77 82 86 91 96
625.00 110 115 120 125 130 $22.10 625.00 87 93 98 103 108
675.00 120 126 131 137 143 675.00 98 104 109 115 121
725.00 131 137 143 149 155 725.00 109 115 121 127 133

1999 $0.66 $0.69 $0.71 $0.74 $0.76 1999 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 87 92 96 101 105 525.00 68 72 77 81 85
575.00 98 103 108 112 117 575.00 78 83 88 93 98
625.00 109 114 119 124 130 $19.61 625.00 89 94 99 105 110
675.00 119 125 131 136 142 675.00 100 105 111 117 122
725.00 130 136 142 148 154 725.00 110 116 122 128 134

2000 $0.66 $0.69 $0.71 $0.74 $0.76 2000 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 87 91 96 100 104 525.00 69 73 78 82 86
575.00 98 102 107 112 117 575.00 79 84 89 94 99
625.00 108 113 119 124 129 $18.16 625.00 90 95 100 106 111
675.00 119 124 130 136 141 675.00 101 106 112 118 123
725.00 129 135 142 148 154 725.00 111 117 123 129 135

2001 $0.66 $0.69 $0.71 $0.74 $0.76 2001 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 85 89 94 98 103 525.00 73 77 81 86 90
575.00 96 100 105 110 115 575.00 83 88 93 98 102
625.00 106 112 117 122 127 $12.44 625.00 94 99 104 109 115
675.00 117 123 128 134 139 675.00 104 110 116 121 127
725.00 128 134 140 146 152 725.00 115 121 127 133 139

2002 $0.66 $0.69 $0.71 $0.74 $0.76 2002 $0.66 $0.69 $0.71 $0.74 $0.76
525.00 85 89 94 98 102 525.00 73 77 82 86 91
575.00 95 100 105 110 115 575.00 84 89 93 98 103
625.00 106 111 116 122 127 $11.70 625.00 94 100 105 110 115
675.00 117 122 128 134 139 675.00 105 111 116 122 127
725.00 127 133 139 145 151 725.00 116 122 128 134 140

NPV* $0.66 $0.69 $0.71 $0.74 $0.76 NPV* $0.66 $0.69 $0.71 $0.74 $0.76
525.00 378 397 417 436 455 525.00 300 320 339 358 377
575.00 425 446 466 487 508 575.00 347 368 388 409 430
625.00 471 494 516 539 562 $77.97 625.00 393 416 438 461 484
675.00 517 542 566 591 615 675.00 439 464 488 513 537
725.00 563 590 616 642 669 725.00 485 512 538 564 591

*NPV is  for 1997-2002, discounted into 1997 $s. *NPV is  for 1997-2002, discounted into 1997 $s

Landowner takes all payment and alternative returns for 1997-2002.
Payment Altern Total

1996 39.26 -12.00 27.26
1997 32.07 -12.00 20.07
1998 34.10 -12.00 22.10
1999 31.61 -12.00 19.61
2000 30.16 -12.00 18.16
2001 24.44 -12.00 12.44
2002 23.70 -12.00 11.70

NPV97-02130.23 -52.26 77.97
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